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Introduction

The CenterView program allows users to easily retrieve
commonly requested data from the Center for Seismic
Studies databases. After retrieving the data from the
database, the user may process it in many ways,
including dumping to flat files, sending to other programs
via interprocess communication, sorting, resegmenting,
etc.

3 In a typical CenterView query, the user specifies a series
of constraints which provide enough information for
CenterView to form a query. CenterView has two
methods of operation. The first method is an X windows
based interface, and the second is a batch mode, which
allows the user to perform a subset of the queries using a
simple command language. This tutorial describes the
basic features of the X Windows interface to CenterView,
and provides a tour through the most common queries.

3 This tutorial assumes that you are running CenterView on
machines at the Center for Seismic Studies and that the
database itself will also be at the Center. If this is not the
case, then some of the exercises may be inaccurate. This
tutorial also assumes that the user is familiar with X
windows and Unix.

I
I
I
I
I
I
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I
Conventions I

Section Conventions I

CenterView follows the conventions of the Motif user-interface
environment. The following conventions will help you navigate
through CenterView and this tutorial.

Mouse I

" Only the left button is used in CenterView. To initiate an
action with the mouse, place the pointer where you want the
action to take place, then quickly press and release the left
mouse button. This is called "clicking".

" "Point the mouse" means without pressing the left button
move the mouse until the arrow (pointer) is over the desired
location.

"• "Drag" means press the left button over the text, drag the
cursor until the text becomes highlighted, then release the
button.

* When the mouse pointer changes to a watch icon, CenterView 3
is busy and no action can be taken in the Main window.

Menus/Windows

CenterView menus are located above the main window. To see
the contents of a menu, click on the menu name. To select an item
from the menu, drag the mouse to the item and click.

Fil Query View Options Customize 3
Choose Default Server Ctrl+dI

Connect To Agent

Load File Ctrl+l

Load Table Descriptions

Upload Data

Exit Ctrl+x

I
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I
ConventionsI

Many different windows are displayed in CenterView. TheI windows contain various buttons defined as:

Done Proceeds to the next window after applyingI any changes.

Cancel Aborts the current function and returns to
i the previous window.

Select All Selects all of the items in the list To select
individual entries, click on the selection.

DeSelect All Deselects all of the items in the Nist. To
deselect individual entries, click on the

I selection.

Hide Hide a window, taking no action.

I Dismiss Removes a dialog window.

I Text Fields

I A simple text field consists of a label followed by one input box.

Database Accounts: 11

I Generally, one or more values, separated by commas can be
entered into a simple text field. However, some simple text fields
such as the User Event File field can only take one value.

Range text fields contain two input boxes separated by "to":

I Event Depth: toW

For these text fields the user should supply a range, i.e., enter a
lower bound for the range in the left input box and an upper
bound in the right input box. It is not necessary to supply both
upper and lower bounds:

Phase Type Window: I IIII I to

VelocityWindow: to I?°

I To enter text in an input box:

Move the mouse to the input box and click the left button. The
I border around the input box becomes darker, indicating that it is

CenterView Tutoricl 3
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Conventions I

selected. Type in the appropriate text. Text fields are generally
case-sensitive, although there are some fields where case is
unimportant, e.g., the Database Accounts field.

Use the keyboard to move quickly through multiple input boxes.
To move forward, pre-,; the <Tab> or <Return> keys. To move
to the previous input box, simultaneously press the <Shift> and
<Tab> keys.

To delete text from an input box:

Click the left mouse button at the beginning of the text and drag 3
it to the end of the text segment or double-click to select the
whole text entry. Press the <Delete> key to remove the
highlighted text. You may also use the <BackSpace> key to
delete the text letter by letter.

To move the cursor within an input box: I
Move the mouse to the position where you would like the cursor
and press the left mouse button. Use the left and right arrow keys
to move the cursor.

NOTE: Input boxes retain their values. Values previously entered
will be displayed as the initial value. Throughout this tutorial

there are examples where it will be necessary to delete these
initial values from input boxes. 3

I
I
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Conventions

Help

CenterView provides two types of help:

(1) Every field can be described by a popup Help window. To
display this help, delete the contents of the input box and
press the <Fl> key. On some systems the <Help> key
should be used in place of the <Fl> key. In the example
below, a description for the Event Magnitude field has been
activated. Remove this help window by clicking the
Dismiss button.

tp o0A0.•fim•aiitu-e s•m- f anev .. ,.
Description: Event magnitude. This is the union of the three

types of magnitude (ub,ms,ml) for an event. I
If any of these values fall within the rangeprovided, the origin will be selected. see

ub, as and ml.

Query Parameters

Event Magnitude: to j ~

Event T`e: to

(2) A list of valid choices may be available for some fields. To
display this help, type text in the field and press the <Fl>
key. If this help is unavailable for the specified field, then the
field's description will be displayed instead. The text in a
field detemtines what will be shown in the list. If one or more
wildcard characters (* or?) are present in the field, then the
contents of the box will be treated as a pattern. In this case,
only options matching the pattern will be displayed. The *
character matches any number of characters, while the ?
character matches exactly one character (similar in behavior
to * and ? in most shells).

CenterView Tutorial



I
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In this example, E* was typed in the Database Accounts field
and the <Fl> key was pressed. Select from the list of
displayed accounts and click the Done button to enter your
selection in the field..

Database Accounts: Ej 3
"--'• ' i . .. ....... ...... RIM M N ...... 1 I'SlSl II I II III l 1 M IZZ• ?

Account Database Server First Year Last Year I Stations I Arrival

a EUSEQK HUGO 1962033 1986031 55

O EUSEXP HUGO 1961344 1966210 29

0 EVENTS HUGO 1993110

o EXPLOSION HUGO 1945197 1992269 864

0 EXPLOHIST HUGO 1957207 1982360 45 9254

1 Done Cace

I
I
I
I
I
I
I
U
I
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Initialization

t Initialization
The instructions below describe how to start CenterView on machines
at the Center. For this tutorial, we will run CenterView on sol.css.gov,
which is one of the more powerful machines at the Center and is
intended for research and data retrieval.

6/ To give sol permission to see the display on your local machine,
type:

xhost +sol.css.gov

V To log into sol from a UNIX system, type:
rlogin sol.css.gov -1 username

where username is your account name at the Center. If you do not
have an a count at the Center, contact the Center's system
administrator at (703) 276-7900, or you can use the CenterView e-
mail interface. For information on this service, send e-mail to
cssinfo@seismo.css.gov, with the subject as "help".

V To specify that CenterView should be displayed on your local
machine, type:

setenv DISPLAY machine.xxx.yyy:O

where machine. xxx. yyy is the complete intemet address of your
local machine. If you are running a shell other than csh, you may
have to use a different command to set your display. For example, if
you are using ksh you will have to type:

DISPLAY=machine. xxx. yyy: 0

followed by:
export DISPLAY

If you are using a different shell, check the manpage for the shell to
get help on setting environment variables.

V To use CenterView in conjunction with other programs, e.g.,
geotool or Map, you will have to start ISIS and the CommAgent.
Appendix B of this tutorial explains the steps necessary for running
CenterView with other progranms. Examples are also provided later ;n
this tutorial.

V Before you start CenterView, you must set the ROOTPATH
environment variable.
CenterView reads a number of configuration files at start time. These
files are located in th'" directory /nmrd/rel. Therefore, it is necessary
to set the ROOTPATH environmient variable to /nmrd/rel (See the
notes for setting the DISPLAY environment variable).

C.ent-rView It itonial
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Initialization I

V Make sure that you are in a writable directory:
During this tutorial we will be using CenterView to dump data to
disk. To simplify this you should be in a writable directory. If you are
not sure what directory you are in, you should return to your home
directory by typing: 5

cd

V To start CenterView, type: U
CenterView

Several messages will appear indicating that several startup files have
been read. If there are errors in opening any of these files, it is likely
that your ROOTPATH environment variable is not set correctly (see
above).

II
I
I
I
I
I
I
I
I
I
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I
The Main WindowI

I • The Main Window

Once the Scheme extensions have been initialized, the main
CenterView window is displayed. If CenterView is unable to initialize
interprocess communications, a "No Agent Connection" message box
will also be displayed. This message indicates that ISIS and the
CommAgent are not currently running, and that CenterView will be
unable to communicate with geotool and the Map program.

File Query View Options Customize

Data Types

0 Detection Parameters 03 Station Parameters

3 0 Event Parameters 0 Waveforms

Database Accounts:3 No Agent Connection

Unable to Initialize process communications. To establish
communications, check to see that ISIS and the CommAgentI are running, and choose Connect To Agent from the File menu.

I - - -•ii

Click the Dismiss button to close this window. If you are able to
resolve the problem, you may choose the Connect to
CommAgent item from the File menu, which will display the
Connect to Agent window:

[Connect To Aqe,,l

I Agent Name:

SIS Port

Use this window to specitv the Agent Name and ISIS Port. Click the

SConnect button to initialize the specified process communications
or click the Cancel button close the window without connecting to
an agent.

I9
I
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I
Connecting to a Database Server I-1 1 1 Connecting to a Database Server 3

Before CenterView can perform a query, it must be connected to a
database server. By default, CenterView connects to hugo, which is
the database for the central data repository.

1. Choose Default Server from the File menu.
A Server List window is displayed. This window lists the
available database servers with a brief description of each. In the
example, the server HUGO has been selected. 3

Iever Lis-

Server Description
elsViD CSS IMS Operations (Arlington, VA)e

* ERLIK CSS IMS Operations (Arlington, VA)

*HUGO CSS Central Data Repository (Arlington, VA)

4>SOL CSS Research (Arlington, VA)

2. Select HUGO and click the Done button.

The Database Accounts field specifies the accounts from which
data will be retrieved. One or more accounts may be listed in this
field.

File Ouery View Options Customize

Data Types

0 Detection Parameters 0 Station Parameters

0 Event Parameters 0 Waveforms 3
Database Accounts: _ __ _

1

Unless otherwise specified, all database accounts entered in this field
are expected to reside on the database server chosen as the default
server. If this is not the case, then @server-name may be appended to
the account name. This indicates that the account resides on the 1

10 C'enterview rutonol



Connecting to a Database Server

specified server.

You can enter a Database Account in two ways:

a) Type the account name in the Database Accounts field, or

b) Type * in the Database Accounts field and press the <FI> key.

A Help window will be displayed. This window lists the available
database accounts, provided that you are connected to a database
server at the Center. Use the scrollbar to view all of the accounts.
Select an account name and click the Done button. In this example,
the GSETT account has been selected.

Annount Outabas. lemrUH First Zear Last 1-. 1 Itaoln. I Ar.rival. I Origin. I WfdLSo. a Oftapas
U - bb 196135 1191154 191 95111 46UT IUOUIIS

0011 HUGO 1976001 1991106 76 207290 95331 2009964

OWDO HUG 1990065 1990065 27 368 is 504

1990015 1191154 191 83408 3288 100099

O S U19422 1907102 101 9OS.IS 147 436
000100011) 0000., 1963256 1981361 146 100 9762

P
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I
A Simple Event Query I

m ' ii ASimple Event Query I
This query retrieves event information from a database. Later
examples will demonstrate further uses of the query results.

1. Click on Event Parameters under Data Types.
Constraint Types are displayed for the Event Parameters.

2. Click By Event Time and By Event Magnitude in the
Constraint Types list.
Query Parameter fields are displayed for Event Time and Event
Magnitude. Use these fields to specify the values that will be
used to form the query.

File Query View Options Customize

Data Types

03 Detection Parameters 0 Station Parameters

IN Event Parameters 0 Waveforms

Database Accounts: IJGSETT

Constraint Types

"o By Event Author 0 By Event Type

"1 By Event Location 0 By Geographic/Seismic Region

10 By Event Magnitude 0 By MbIMsiMI

9l By Event Time 0I By Number of Defining Phases

Query Parameters 3
* Event lime: 151911to 15391

3. Enter 4 and 4. 5 in the Event Magnitude fields. Enter 5/1/91_

and 5/30/91 in the Event Time fields.
This query will retrieve all events that occurred between 00:00 on
May 1, 1991 and 00:00 on May 30, 1991 that had a nib, ms, orml
magnitude between 4 and 4.5.

4. Select Run Query from the Query menu.
While the query is running, CenterView displays an Abort
window with two options: Abort and Dismiss. The Abort button
terminates the query. It is provided for times when the query is
taking longer than expected, or when an error has been noticed
after the query has been started. The Dismiss button closes theI
Abort window without terminating the query. The user may then
further specify the query constraints in the View window.

12 CenterVew Tutorial



I
A Simple Event QueryI

-----i --------- --

The query Is running. To terminate the query. press Abort,

To remove this window without terminating the query, .press
Dismiss.

FA-bortl Dismss

If the number of rows produced by the query is so large that it would
impact the performance of CenterView, only a limited number will be
displayed. This Maximum is set to 200 rows by default. In the event
that CenterView truncates the result list, a window will appear3notifying you that there are more rows than are actually displayed.

O runcated Result Us

The result list for this query contains 237 rows.
which is too large to fit In one display. Only the
first 200 rows will be displayed.

Dimiss

5. Click Dismiss in the Truncated Result List window.

CenterView displays default columns from the most significant
database tables involved in making the query. For this query,
origin.etoh (the origin's epoch time to human time), origin.lat (the
origin's latitude) and origin.lon (the origin's longitude) are displayed.

1 _,
esult List

File Query View Data Download Options Send

I )Result List #1

origin.etoh origin.lat origin.lon J

1115/1/91 02:57:15.5 -26.5042 -177.5178

B 5/1/91 03:01:02.4 -11.7271 -166.4709

[ 5/1/91 03:06:48.8 42.2588 44.3989

[] 5/1/91 03:38:12.0 42.5092 43.7230

M 5/1/91 04:39:06.7 -2.0415 120.8861

IN 5/1/91 05:13:37.4 42.5975 43.77333 Select Alloeseec A,

You have now completed your first CenterView query. In the next
example we will use the results of this query.

I

3 CernterVie•w Tutoriaql 13



I
Naming Queries I

111. Naming Queries I

You can assign a name to each query for later use.

1. Click the mouse on the text labeled Result List #1.

es
File Ouery View Data Download Options Send

IResult Ust *II
origin.etoh origin.lat origin.1lon I

105/01/91 02:57:15.5 -26.5042 -177.5178

1105/01/91 03:01:02.4 -11.7271 -166.4709 3
105/01/91 03:06:48.8 42.2588 44.3989

*05/01/91 03:38:12.0 42.5092 43.7230

*05/01/91 04:39:06.7 -2.0415 120.8861 3
11105/01/91 05:13:37.4 42.5975 43.7733

You may now use the same methods described earlier for editing text
in an input box to change the name of the query. I
2. Enter the text First Event Query into the input box.

Wesult Us

File Ovuel View Data Downlfad Op/ions Send

First Event Query

origin.etoh origin.lat origin.lon I
105/01/91 02:57:15.5 -26.5042 -177.5178

W 05/01/91 03:01:02.4 -11.7271 -166.4709

RO05/01/91 03:06:48.8 42.2588 44.3989

1*105/01/91 03:38:12.0 42.5092 43.7230

M 05/01/91 04:39:06.7 -2.0415 120.8861

I105/01/91 0S:13:37.4 42.5975 43.7733 3

14 CenterView Tutorial



Continuing a Query

o Continuing a Query

You may continue using a query by adding new constraints to an
existing result list. For instance, a large number of events were
selected in the previous query. It may be useful to find all of the
detections at a small number of stations for some subset of those
events.

For this example, we will display event and detection information for
associated P phases at ARAO, NRAO and FIAO, for all events in the
previous query.

1. In the Result List, select Continue Query from the Query
menu.
The Continue Query window is displayed. This window is similar
to the main CenterView window except it retains default
information from the current query.

i ............. ...Cont,.'ue Quet

File Query

Data Types
I •W Detection Parameters 0] Station Parameters

91 Event Parameters 07 Waveforms

Database Accounts: ITSETT@HUGO

Constraint Types

u tsy uetecuon lime u tsy ueograpnicibeIsmIc Kegion

0 By Event Author 0 By MbIMs/MI

o By Event Location IN By Network/Station/Channel Code

SBy Event Magnitude 0 By Number of Defining Phases

o By Event Time R By Phase Name

D i tQuery Parameters

Detection Method: By Event Associations -j

Network/Station: .ARA0.NRA0.F0

Expand Networks:

Channel: II I

Initial Phase: z :: i

Associated Phase: l-P

I
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I
Continuing a Query I

2. Click Event Parameters and Detection Parameters under
Data Types, as shown above, so that they are both highlighted.
The Continue Query window will display additional constraint
types relating to the Detection Parameters.

3. To apply additional constraints to the query, dick the By I
Phase Name and By Network/Station/Channel Code
constraint types.

4. Since we are interested in associated P phases at ARAO,
NRAO, FIAO, type P in the Associated Phase field and type
ARAO, NRAO, FIAO in the Network/Station field, separated by I
commas.

5. In the Continue Query window, select Run Query from the
Query menu.
A result list is displayed. Since there is more than one detection
for a given event, there may be many copies of the same event in
the result list, each with a different detection. In general,
CenterView displays all distinct combinations of results.

*$u,.t1,.•

File Query 'View Data Download Options Send

I)Iesult List 52

origin.atoh origin. lat origin. Ion arrivalst. arrivaliphaso arrival.•toh

H 5/1/91 03:06:40.6 42.2500 44.3969 ARtAD p 5/1/91 03:12:49.0

U 5/1/91 03:06:48.8 42.2588 44.3989 KRA0 P 5/1/91 03:12:32.0

15/1/91 03:38:12.0 42.5092 43.7230 ARAD P 5/1/91 03:44:11.6

8 5/1/91 03:38:12.0 42.5092 43.7230 NPAO P S/1/91 03:43:50.1

U 5/1/91 05:13:37.4 42.5975 43.7733 ARA0 P 5/1/91 05:19:32.3

US/1/91 0S:13:37.4 42.$975 43.7733 vRAO P S/1/91 05:19:14.3

We will now explore some of the uses for the results of a query.

I
I
I
I
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Displaying Columns

c Displaying Columns
The Result List displays only a few columns from each database table
used for the query. Often there are other columns that are of interest,
and CenterView allows you to display columns other than or in
addition to the default columns, and also allows you to reorder them.
For this example we will add the column origin.mb and reorder the
columns.

1. In the Result List choose Display Columns from the View
menu.
A Display Columns window lists categories which can be
selected as columns. Scroll through the list to see currently
selected categories; they are numbered by the order in which
they appear in the Result List. For example, origin.etoh appears
as the first column of the Result List and is numbered "1".

1 Elorigin.etoh origin.time (human ormat

Oorigin.etype event type

n origin.evid event idI origin.grn geographic region number

Oorigin.jdate julian date

2 8 origin.lat estimated latitude

0Oorigin.lddate load date

3 Ilorigin.lon estimated longitude

Dc Hide

2. Click the Deselect All button in the Display Columns
window.

3. Scroll to origin.mb and select it; it becomes #1. Continue
selecting categories in the following order: (2)origin.etoh,
(3)origin.lat, (4)origin.lon, (5)arrival.sta,
(6)arrival.iphase, and (7)arrival.etoh.

4. Click the Done button to apply the changes.
After a brief delay, CenterView displays the Result List in the
newly-defined order.

Corfl(jrView Tklto al 17



I
Sorting I

Seo Sorting
In addition to selecting the columns displayed as the Result List, you
can reorder the rows by selecting columns to sort by. You can also I
specify whether to sort the rows in ascending or descending order.

1. In the Result List, choose Sort Columns from the View
menu.
A Sort Columns window lists the columns for sorting. Selected
columns are numbered by the order they appear in the Result List. I
By default, the rows are sorted in ascending order by
(1)origin.time, (2)origin.lat, (3)origin.lon, (4)arrival.sta
(5)arrival.iphase, and (6)arrival.time. NOTE: The rows were first
sorted by origin.time but displayed in human time because
origin.etoh would sort the rows by alphabetizing each origin.etoh
string.

...... .. 6..............
Sort Direction: Ascending c

" origin.orid origin id

" origin.srn seismic region number

1 *origin.time epoch time

0 query query name

o server server name

0 site.account site account

a site.deast offset from array reference (km)

FDone A

2. Click the Deselect All button in the Sort Columns window.

NOTE: To deselect one category at a time, press the <Shift> key
and click on the category.)

3. Select column origin.mb. It becomes #1.

4. Continue selecting columns, e.g., (2)origin.time,
(3)arrival.sta, (4)arrival.iphase.

5. Specify Ascending or Descending in the Sort Direction
box. I

6. Click the Done button to apply the changes.
After a brief delay, the Result List is displayed in the new order.
In this case, only the first three columns were necessary to
complete the sort (i.e., no two rows contain identical data for ( I),
(2), and (3), therefore it was unnecessary to select colunn (4)).

18 CenterView Tutorial



Closing Result List Windows

I Closing Result List Windows
When doing more than one query in CenterView, the screen can
become cluttered with windows from previous queries. These
windows can be hidden, with their results retained for use later in the
session.

1. In the Result List window named Result List #2, choose Close
from the File menu.
The window will be removed from the screen.

2. In the Result List window named First Event Query, choose
Close from the file menu.
This window may be hidden underneath the Continue Query
window. If this is the case, then you may first choose Close from
the File menu of the Continue Query window.

To retrieve a result list:

3. Choose Result List from the View menu.
A list of all the result lists generated in this session will be
displayed

0 First Event Query]

I 70 Result List #2

I ___

4. Choose First Event Query from the list, and click Display.
The result list from the first query in this tutorial will be

I displayed.

5. To remove the Results List window, click Hide.
This window may be hidden underneath the First Event Query
result list window. If this is the case, then you may first move the
Result List window out of the way to expose the Results List

I window, and then click Hide.

I
I
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SII.p Formatting Bulletins I
You can format bulletins when your result list is from a query that was
for Event Parameters. When formatting a bulletin, you have the I
option of displaying the bulletin in a popup window, saving the
bulletin to a file, or printing the bulletin.

To choose a subset of events to be included in the bulletin:

1. Click on Deselect All in the Result List window. I
2. Select the first 4 events in the list, as shown below. I

esult ULis

File Quety View Data Download Options Send

First Event Quer•i

origin.etoh origin.lat origin.lon

8 05/01/91 02:57:15.5 -26.5042 -177.5178

1105/01/91 03:01:02.4 -11.7271 -166.4709

E005/01/91 03:06:48.8 42.2588 44.3989

rE105/01/91 03:38:12.0 42.5092 43.7230

005/01/91 04:39:06.7 -2.0415 120.8861

005/01/91 05:13:37.4 42.5975 13.7733

Seec AlDeseect AllI

3. Choose Format Bulletin from the Data menu.
The Format Bulletin window will appear.

Aonnat Bulletin

Output: Display in Window E

Output Format: F ASCII

Output Filename EIZZJ
FFormat BulletinCI

To display a bulletin in a popup window: 1
4. Click the Output button to Display in Window.

5. Click the Output Format button to ASCII.

I
I
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6. Click the Format Bulletin button.
After a short period of time, a text window will appear,
containing the bulletin for the selected events.

nt Bulleti

BULLETIN
of the

Center For Seismic Studies
GSETT

Date Time Lat Lon Smajor Sminor Strike Depth ML Mb
5/1/91 02:57:15.5+-0.4 -26.5 -177.5 301.7 49.9 166.6 33.0+-8.0 4.2
SOUTH OF FIJI ISLANDS

Sta Dist Ph Time Tres Azim Ares Slow Sres Def Snr Amp Per
CTA 33.8 P 03:03:54.4 0.7 T
ASAR 43.8 P 03:05:17.9 0.4 92.0 -12.3 7.5 -0.5 TAS 5 0.4
WRA 44.5 P 03:05:22.0 -1.2 104.0 -4.1 7.6 -0.3 TAS 4 0.3
NRAO 145.2 PKP 03:16:48.9 0.0 22.0 7.7 3.1 1.4 TAS 0 0.4

Date Time Lat Lon Smajor Sminor Strike Depth ML •b
5/1/91 03:01:02.4+-0.4 -11.7 -166.5 281.6 36.5 137.8 33.n+-O.O 4.0
SAMOA ISLANDS REGION

Sta Dist Ph Time Tres Azim Ares Slow Sres Def Snr Amp Per
STK 51.7 P 03:10:05.6 0.1 T
WRA 57.2 P 03:10:45.9 0.4 90.0 -1 q 7.4 0.4 TAS 2 0.2
ASAR 57.6 P 03:10:47.6 -0.5 87.0 -2.1 8.5 1.5 TAS 6 0.5
YKA 84.3 P 03:13:30.4 0.0 145.0 -85.7 4.0 -1.0 T 0 0.8
YKA 84.3 UNK 03:13:38.0

FD'ims

7. When you are done browsing the bulletin, click Dismiss.

To write the bulletin to a file:

8. Choose Format Bulletin from the Data menu.

9. Click the Out,-ut button to Output to File.

10. Click the Output Format button to the desired format.
The Postscript format can be used if the file will eventually be
sent to a postscript printer. The ASCII format produces files
which are readable without applying any post processing, and
nroff/troff options produce files which can be filtered through the
standard UNIX typesetting programs to produce formatted
output. If you are not sure which format to use, you should select
ASCII.
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11. Enter the name of the file to dump to into the Output
Filename field, as shown below (here, we have used
bulletin. gsett as the filename).

ormat Bulletl 3
Output: Output to File c3

Output Format: [IF c,,1
-7-7._r__

Output Filename i builetin.gsetI

Format Bulletin -C nc

12. Click the Format Bulletin button.

After a short period of time, the Format Bulletin window will
disappear. At that point, the file will have been created. To look at
the file, you can type more bulletin. gsett.

13. Choose Close from the File menu of the Result list.
You are now done working with this result list. In the next
section, we will perform some more complicated queries. 3

I
U
I
I
I
I
I
I
U
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I Predicted Arrival Times
Often, a user will want to search for waveforms in a database account
which has not been set up with links between events and waveforms
In this case, CenterView can search the database for waveforms
which overlap a time window determined by computing theoretical
travel times2 for the desired events.

The next example demonstrates this capability by searching for3 waveforms in the GSETT database account for an event on May 29,
1991.

1. Select Clear Query from the Query Menu in the
CenterView window.

2. Select Event Parameters and Waveforms from Data
Types.

3. Enter GSETT in the Database Accounts field.

Specify event information:

3 4. Select By Event Time from Constraint Types.

5. In the Event Time fields, enter 5/29/91 18: 00: 00 and
5/29/91 20:00:00.
This specifies events that occurred between 18:00 and 20:00 on
May 29, 1991. It is not necessary to enter times that will
uniquely specify one event. CenterView will provide a list of
matching events before performing the waveform query.

Specify houw to retrieve the waveforms, given the event:
We are interested in finding all waveforms which overlap with a
time window beginning 30 seconds before the theoretical P3 arrival time and 120 seconds afni tL, theoretical P arrival time.

6. Click the Waveform Type field Online.

3 7. Enter data in the Phase Typc \ iimdow field, Velocity Window
field, and Time Buffer field as shown in the next figure.
The Phase-Type Window and Velocity Window specify the same
information i.e., the window start and end times relative to the
event. If minimum or maximum values are entered in both the
Phase Type Window and Velocity Window fields, then the value
entcred inlto the Velocity Window field will take precedence.

I. using a CSS Version 3.0 wftag tablc

2. currently haisd on the IASPE-91 travel lime curvcs
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Predicted Arrival Times

en-e~
F:"e Query View Options Customie

DataTypes

o Detection Parameters 0 Station Parameters

II Event Parameters 9 Waveforms

Database Accounts: I GSEl-•I

Constraint Types

ol By Event Author 0 By Geographic/Seismic Region

o By Event Location 0 By MbIMsiMl

o By Event Magnitude 0 By Network/StationlChannel Code

@I By Event rime 0 By Number of Defining Phases

o By Event Type 0 By Waveform Time

Query Parameters 3
Waveform Type: [Online-

Waveform Method: By Predicted Time - 3
Phase Type Window: 1 11to Il Il
Velocity VWindow: [ZI to IIl l
rime Buffer: 130 to EII Z II]
Station Distance: to E Z ZI
Event Time: 1rl 8W:0 to I'r99 0*~

8. Select Run Query from the Query menu. I
An Intemiediate Results message will be displayed.

~Result List I
File Query View Data Download Options Send

]Result List I ntermediate Resutls 3
or The results in this window are not the final results

!I of your query. This list of results has been presented I

W 05/29/c so that you may choose a subset with which to continue
0[]05/29/€. the query. :

E[ 05/29/c When done selecting from this list. hit the'"Resume Query' button at the bottom of the

[] 05/29/c window. 3
[] 0S/29/c.

[] 05/291c- [

IRes.me Ouery Is leselect AlI

I
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Predicted Arrival Times

This message states that the displayed Result List is not thefinal
result of the query. Dismiss this window. The Results ListI displays all events (but no waveforms) which occurred during
the specified time. From this Result List you can select the
events for which you want waveforms. It is best to keep this list
small since waveform retrieval can be a time-consuming
process.

For this example, we will use the event of a nuclear blast from
the Muraroa test site which occurred at 19:00:00.8.

9. Deselect all of the events by clicking the DeSelect All
button.

10. Select the event with the origin time 19:00:00.8.

. r~esult Usl

3Fle Ouery View Data Download Options Send

)Result Ust #3

origin.etoh origin.lat origin.lon J
S005/29/91 18:07:56.0 0.5996 131.4075

0 05/29/91 18:14:26.8 -3.3545 98.1992

0 05/29/91 18:32:12.2 -5.4597 127.9486

IN05/29/91 19:00:00.8 -22.1093 -138.8229

0 05/29/91 19:09:35.1 61.1765 10.46243 05/29/91 19:34:31.2 51.3562 -173.1435

Resume QueryI Seec AlDeselect All I
Ii

11. Click Resume Query in the Results List window.
The query will resume execution. After a brief delay, the results
will be displayed.
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12. Rename the result list to First Waveform Query.

If you do not remember how to rename queries, refer to the
section on renaming queries.

esult Us

File OQuey View Data Download Options Send

First Wavelorm Quer•[

wfdisc.sta wfdisc.chan vf.retoh wf.rendetoh J 3
"lAQU s2 05/29/91 19:19:17.6 05/29/91 19:21:1

"EARA0 cb 05/29/91 19:10:46.0 05/29/91 19:20:3:

"EARAO sz 05/29/91 19:1:46.0 05/29/91 19:20:3:

"*AS12 sz 05/29/91 19:11:37.8 05/29/91 19:13:3

" ASAR cb 05/29/91 19:11:37.5 05/29/91 19:13:3 f
I0- ,01 1, 0.1A-AC
FDec Al es el-ec. TAll

You have now completed this query. We will use the results from
this query in a later section on dumping wavefomis.

13. Close the Result List window.

14. Close any remaining result list windows. 3
I
I
II
I
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I More Predicted Arrival Times
Types of data other than waveforms can be retrieved by predicted
arrival times. In the next example, predicted arrival times are used to
retrieve detection parameters. In these queries, the user, rather than
the database, supplies the events.

1. Create a file containing the event that you are interested in.
Using your favorite editor, create a file named events (the file
namne is unimportant) in the same directory that you started
CenterView. We will use the same event that was used in the
previous query. An event file can contain any number of events.
Each line in the event file denotes a new event and should contain
a latitude, longitude, depth and time, in that order. The time
may be specified in either epoch tine or human readable time.
Any extra data at the end of the line will be ignored, therefore,
you can use CSS 3.0 origin files.

2. Enter the following line into the newly created events file and
save it.
-22.1093 -138.8229 0.0000 5/29/91 19:00:00

3. Since we are interested in retrieving detection information,
select Detection Parameters from the list. No other items
should be selected.

4. Enter GSETT into the Select Account field.

5. Select By User Event File from the Constraint Type list.

6. In the User Event File field, enter the pathname for the newly-
created events file. Continue entering the constraint
information as follows:

Query Parameters

User Event File: ne/gymero nt

Phase Type Window: to

Velocity Window: t I to [.0j
Time Bufer: 1-10 to ljo j ]j

Station Distance: 1m 1to t

For this query we will select detections that arrived within 10
seconds of the predicted arrival time of the P phase. CcnterView
will use the event in the newly-created file.
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F'He Que-y View Options Customkie

Data Types

* Detection Parameters 0 Station Parameters

o Event Parameters 0 Waveforms

Database Accounts: IGSETI 0

Constraint Types

" By Anrival Author 0 By Phase Name

"o By Detection Time 0 By Station-Event Azimuth

"o By Event-Station Azimuth 9 By User Event File

[o By NetworklStation/Channel Code

Query Parameters

User Event File: neigymedferarroleventi

Phase Type Window: li to I T

Velocity Window: to II I

Time Buffer: to-0 Ito 15

Station Distance: I Z I to]

_ __ __ _I

7. Select Run Query. 3
Intermediate results will not be displayed since you have supplied
CenterView with the exact list of events in which you are
interested. When the query has finished running, the Result Listwill be displayed.

W iesu-lt Us

File Query View Data Download Options Send

Ilesult List #7

arrival.sta arrival.iphase arrival.etoh site.sta site.1I

RJAQU P 05/29/91 19:19:47.5 AQU 42

*IAQU Pn 05/29/91 20:25:39.5 AQU 42

"IAQU Sn 05/29/91 20:26:23.2 AQU 42

" ARA0 Lg 05/29/91 20:44:55.0 ARA0 69

HlARA0 P 05/29/91 19:19:14.0 ARAO 69

Sel ectll -es eect Aul o



Dumping Query Results

gDumpiRg Query Results

Query results can be dumped to CSS 3.0 format files or the columns
displayed on the screen can be dumped to disk. The following
example demonstrates the different methods by which results can be
dumped.

Dump the results in CSS Version 3.0 Format:

1. Choose Download to Flat Files from the Download menu in
the Result List.
The Result List (as you see it) is dumped to a file. The Dump to
Flat Files window will display a list of all tables that can be
dumped from the current query.

SDidFile Prefix: t m , r

SI El arrival origin 0 tharr

30 event 0 site

0 origerr 0 stassoc

2. Select arrival and enter myf ile (or any filename prefix) into
the Dir/File Prefix field.
This string will be used to create one file named myfile.arrival.

3 3. Click the Dump button.
CenterView will dump the data to CSS 3.0 format and will
display a window describing how many rows were dumped and
to which files.

107 arrival rec to thomelgymer/ferrarolmyfile.arrival.

3 4. Dismiss the Data Dumped window.

5. Hide the Dump To Flat Files window.

Dump the results as they appear in the Result List window:

3 6. Select Download Results from the Download menu.

7. Click Yes in the Include Header field.

I
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File Name: yhome/gymernferrarao/myfile2

Delimiter: TabDelimited -I

Include Header:

8. Click the Dump button.
The result list, as displayed in the Result List window, will be

output into the named file.I

I
I
I
I
I
I
I
I
I
I
I
I
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t Sending Results to the Map

CenterView can send query results to other programs. For example,
station, event and detection data can be sent to the Map program and
waveform data can be sent to the geotool program.

To send data to other programs, ISIS, the CommAgent, and the
destination program (Map or geotool) must be running. Refer to
Appendix A for instruct ')s for starting these processes.

In this exampi, e will send CenterView query results to the Map

program. NOTE: The Map program requires a color display.

1. Make sure that ISIS and the CommAgent are running.

2. In CenterView, select Connect to Agent from the File menu3= in the main CenterView window.

AgentName: I I
ISIS Port: 1164I

3. Enter the Agent Name and ISIS Port in the appropriate fields.

4. Click the Connect button.

5. Perform a simple event query.3 In this example, we've used the query from section A, except
we've restricted the Event Magnitude field to be from 4 to 4.1.
(By further restricting the results, we are reducing the amount of
data sent to the map). To see the number of results generated,
select Result Count under the Data menu in the Results List.

3 Send the query results to the Map program:

6. Run the Map program.

i 7. Select Map Options from the Results List Options menu.
The Map Options window will appear. Use this window to
specify which data should be sent to the map.

I
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I 4I

Destination: )•4ap

Map Data Types

91 Event Locations 0 Event Error Ellipses

Event Locations I

Symbol: p I

Size

Color: ;White 3
I

8. Choose your favorite color and enter it in the Event Color 3
field (for this example, we use White).

9. Click Send to send the results to the Map program.
The events from the working query will be displayed on the map.

10. Close the Result List window. 3

I
I
I
I
I
I
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Sending Results to geotool

S Sending Results to geotool
When a result list contains online waveforms, CenterView can send
these waveforms to geotool. As with sending to the Map program,
you must first make sure that interprocess communications are
initialized properly (see section 15 on Sending Results to the Map).

For this example, we will use the results from the first waveform
query in this tutorial.

Display the results from the previous query

1. Choose Results List from the View menu.

3 Rffesults Lis ,

O First Event Query

0 Result Ust #2

0 Result List #3

o Result List #4

9] First Waveform Query

0 Result List #6

0 Result List #7

2. Click on First Waveform Query.

3. Click on Display.

The result list will be displayed.

File Query View Data Download Options Send

First Waveform Queri{

wfdisc.sta wfdisc.chan wf.retoh wf.rendetoh

zIAQU s2 05/29/91 19:19:17.6 05/29/91 19:21:1

M ARAO cb 05/29/91 19:18:46.0 05/29/91 19:20:3:

S ARAO sz 05/29/91 19:18:46.0 05/29/91 19:20:3:

91 AS12 Sz 05/29/91 19:11:37.8 05/29/91 19:13:3 13 ASAR cb 05/29/91 19:11:37.5 05/29/91 19:13:3
S"C l r AD f., -flC.19 0.1 O-Ifl. AG 9 f I' IQ I_ 1A-91 .. ,I~~ ~ SeetAlDeselect AllI

4. Run the geotool program (see Appendix B for more
information on running geotool).
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5. Select a small number of rows from the result list.

6. Select Send to geotool from the Send menu. I
After a short time, the waveforms will appear in the geotool
window.

aeoto,

File Edit View Option Help

I
kUbAR c

, I I

0 100

I
I
I
I
I
I
I
I
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Dumping Waveform Data

Section Dumping Waveform Data

One of the most commonly used (and abused) featureq of CenterView
is the dumping of waveform data to disk. Both online data on
mounted file systems and offltine data (on tapes referenced in the
wftape records in the database) can be dumped. Since the retrieval of
offline data from tape requires operator intervention, it is more time-
consuming than online vaveform dumping and should always be
considered carefully.

For this example, we will use the same result list that was chosen in
the previous section. If you skipped section 16 on Sending to
Geotool, please perform steps I - 3 from that section to select the
necessary result list.

1. Click Select All in the Resilt List window, to make sure that
all the waveforms are selected..

File Ouery View Data Download Options Sena

FFirst waveform Queri.J

wfdisc.sta vfdisc.chan wf.retoh wf.rendetoh

MIAQU sz 05/29/91 19:19:17.6 05/29/91 19:21:1'

EIiARAO cb 05/29/91 19:18:46.0 05/29/91 19:20:3:

01ARA0 sz 05/29/91 19:18:46.0 05/29/91 19:20:3:

EJAS12 sz 05/29/91 19:11:37.8 05/29/91 19:13:3'

EJASAR cb 05/29/91 19:11:37.5 05/29/91 19:13:3.

IL"vn01• flnO/01 10.10.40 nci90og1 I0.011

SeecIAl eselect Amll

2. Select Download Waveforms from the Download menu in
the Result List window.

A Download Waveforms window will be displayed.

This window allows the user to specify how the waveforns
should be d(umped. The User Name field should contain the user
name to which mail will be sent upon completion of the
waveform dump.
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-ownoa wav,,oni i
Output Directory: Isol oa Jth _ _ _ _ _ _ _ _ _ _ _ 

I
Filename Prefix: 1,ata

Waveform Options: Use Resegmented Waveforms c3

Dump Options: One Waveform File :

Eliminate Overlaps: Ye

User Name: lferraro

Notify When Done: 3 -

Output Data Type
J+No conversion I I" all ASCII single precision

" >be ASCII double preci~sion

Maximum File Size: [

Starting Waveform ID: _ __ _

We will use the default values for each of these fields which will
give the waveform files a prefix of dump and will place a
subdirectory in sol'tch on sol.

3. Click the No Conversion button to On.
CenterView will leave the waveforms in the format that they were 3
originally stored. Note: In most cases, you will want to convert
the waveforms to a format that will be useful on the machines you

work- on.

4. Click the Download button.
A Waveform Job Submitted window will be displayed. This 3
window shows the job number and the name of the directory
where the waveforms have been dumped. In this example, the job
number is 11954 and the directory is /itch/WavefomniJob. 11954.
The message also states that mail will be sent upon job
completion.

Iaaveform Job Submitted, '"i

Your waveform request has been submitted as job #11954.

The results of this request will be placed in the directory
ritch/WaveformJob.1 1954 on sol.

You will receive mail upon the completion of the job.

F~issi 3
I
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5. Click the Dismiss button.3 After a brief delay a mail message will be delivered.

Your waveform request has finished at Tue Jul 20 10:55:34 EDT 1993

The data has been placed on sol
in the directory: /nfs/ndegei/var/tmp/WaveformJob.11954
A copy of the output log can be found in the above directory
in the file: data.log

I For the rest of this example, you will need to substitute your job
number for the job number of this example, 11954.

6. rlogin to sol and go to the dumping directory by typing:
cd /itch/Waveformiob. 11954

3 7. To get a listing of the files that have been created, type is.
In this directory, you will find three types of files.

(1) The first type is the wfdisc file. There should be a file called
data.wfdisc. This file contains CSS Version 3.0 wfdisc
records for the data that were dumped.

I (2) The second type of file in the directory is the waveform file.
This file will be named data.w. If a Waveform Method other
than One Waveform File is chosen, then more than one file
will be created, with names like data.XXX.w, where XXX is
the wfid or station for the wfdiscs contained in the file.

(3) Finally, there is a log file, which contains some information
about how the dump was done.

8. Click Hide in the Download Waveforms window.

9. Close the Result List window.

I
I
I
I
I
I
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i A More Complicated Example

To illustrate some advanced features of CenterView, the next example
will locate an event in one database account and search for matching
waveforms in another account.

We will begin by searching for the Soviet nuclear test that occurred
on October 24, 1991. We will search for this event in the
EXPLOSION database account.

1. Clear Query.

2. Select Event Parameters from the Data Types list.

3. Enter EXPLOSION into the Database Accounts field.

4. Since we know the date of the test, select the By Event Time
constraint type.

5. Enter 10/24/90 and 10/25/90 into the Event Time fields.

File Query View Options Customize

Data Types

o Detection Parameters 0 Station Parameters

* Event Parameters 0 Waveforms

Database Accounts: I EXPLOSION

Constraint Types

o By Event Author 0 By Event Type

o By Event Location 0 By GeographiclSeismic Region

o By Event Magnitude 0 By MbIMsM1I

* By Event Time 0 By Number of Defining Phases

Ouery Parameters

Event Time: Ito I,.1

6. Select Run Query from the Query menu.
The Result List displays the queried events from the
EXPLOSION database.
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i 7. Select only the first event from the Result List.

Fde Query Wew Data Download Options Send

IResult List 08

origin.etoh origin. lat origin.lon

1110/24/90 14:57:57.5 73.4100 54.7400

013 10/24/90 14:57:58.1 73.3610 54.7070

To continue the query, we will search for waveforms in the USSR
database account, using predicted arrival times.

8. Choose Continue Query from the Result List Query menu.
The Continue Query window is displayed.

Since we are interested in retrieving waveforms .from the USSR
account for this event,

9. Select Waveforms from the list of Data Types.

I 10. Enter USSR into the Database Accounts field.
Any new information which was not retrieved in the original3 query will be retrieved from the USSR account.

Since the event information was retrieved in the previous query
from the EXPLOSION account, it will continue to be accessed
from the EXPLOSION account, not the USSR account.

Since waveforms were not retrieved in the previous query, they
will be retrieved from the newly specified account, USSR.
Whenever waveforms are retrieved from a different account than
events, it is usually necessary to specify that either Predicted
Times or Associated Arrivals be used as the waveform retrieval
method.

11. Click the Waveform Method field to By Predicted Time.

12. Enter the values as shown in the next figure.
We will assume that we are only interested in waveform segments
that begin 30 seconds before the theoretical P arrival time, and
end 120 seconds after the theoretical P arrival time.
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FeOmContinue Que I 3

Database Accounts: USSF(

Constraint Types

0 By Event Author 0 By GeographlciSeismic Region3

o By Event Location 03 By Mb/MsIMI

o By Event Magnitude 0 By NetworkdStationlChannei Code

o By Event Name 0 By Number of Defining Phases3

o3 By Event Time 0 By Waveform lime

Query Parameters3

Waveform Type: OfIn~eI2

Waveform Method: By Preditdlim

Phase Type Window: [l iip I II to I~ ~ I~i Ii
Velocity Window: tofIIltoI11

Time Buffer: 1-30 to 1)20I

Station Distance: [I I I Z ]to F l l

13. Click the Waveform Type button Offline.
The USSR database does not contain any online waveforms so all

of the waveforms we will be searching for are offline.

14. Choose Run Query from the Query menu.
At this point, you may refer to your scheme window to see the3
query that is being executed.

Executing SQL for query-12: E Jjn

CREATE TABLE Tl¶P_11214 AS
SELECT DISTINCT Tharr.thid center-tharr-thid,

vftape.wfid USSR_wftape-wfid,
TMP_11212.USSR-site-sta USSR-site-sta, Y' SELECTEDI

FROM USSR.wftape wftape,
center.TMP-11212 TMP_11212.
center.TMP-11210 TMP_11210.
center. TMP 11213 tharr

WHERE wftape.enaltime BETWEEN tharr.mintime AND (tharr.mintxime + 86400.0) and
wftape.time BETWEEN (tharr.maztime - 86400.0) AND tharr.maxtime andI
TMP_-11212.i55R_site_sta - wftape.sta and
TMP 11210.EXPW4SION origin orid - tharr.arld and
TMP-11212.USSR site-sta - Tharr.sta and
wftapestall" - tharr.sta and
TMP 1 1212.selected - 'Y' and

TMP-11210.selected - Y

4o CenterView Tutorial3



A More Complicated Example

After a brief delay, the Results List will be displayed.

eesult Us

Rie Queqy View Data Downoad Options Send

IResult Ust #10

site.sta slte.lat site.lon wftape.sta wftape.chan wf.retc

IEARU 56.4000 58.6000 ARU se 10/24/90

W ARU 56.4000 58.6000 ARU sn 10/24/90

MARU 56.4000 58.6000 ARU sz 10/24/90

S ARU 56.4000 58.6000 ARU ye 10/24/90

MARU 56.4000 58.6000 ARU vn 10/24/90fli nf!!RUfffl 56.4000 58.6000 ...U In 10/24/90
W ItDIT ZI Annnn KA arnnn &iD t t•tno

SSelect -AllI FDeseIIet Al

3 Like the previous waveform query, the waveforms in this result list
can also be downloaded. Generally, dumping offline waveforms takes
longer than dumping online waveforms because it requires operators
to search for and mount tapes. Requests for offline waveforms should
thus be given careful consideration before dumping.

15. Close the Result List window.
You have now completed the last query in the tutorial.

II

I
I
I
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I
Exiting CenterView

SI

1ection II Exiting CenterViewI
You have now completed the CenterView tutorial. To exit

1. Choose Exit from the File menu.

2. The Confirm Exit window is displayed.

If you really want to exit, then press 'Confir'COtherwise. press Dismiss'.

3. Click Confirm in this window.
CenterView will shut down after removing any temporary tables
created during the session.

II
I
I
I
I

I
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Helpful Hints

n Helpful Hints
We hope that the following helpful hints can make your CenterView
sessions more productive.

." Help for all text fields in CenterView can be received by typing
the <Fl> key after clicking in the field. For some fields, if there
is text present in the field, typing <F1> will produce a list of
possible choices. In most other cases, a simple explanation of
the field will be presented. NOTE: On some machines, it may
be necessary to substitute the <Help> key for <FI>.

- When performing waveform queries based on theoretical
arrival times, it is better to use small sets of events and stations.
CenterView must compute theoretical arrival times at each
station for each event. If you are looking for waveforms at
5,000 stations for 100 events, it could result in up to 500,000
possible time segments which must be compared to the wfdisc
table. A query of this magnitude could take a very long time. If
there is a specific list of stations that you are interested in, it is a
good idea to constrain the query by station also, and enter the
list of stations. This will greatly reduce the amount of work
involved in running the query.

-" Be aware that queries based on predicted arrival times in the
ISC, EVENTS, EXPLOSION, and NUCLEAR accounts on
hugo may take a considerable amount of time, as each account
contains a very large number of stations.

3 - Pay careful attention when CenterView displays a window
warning you that no tight constraints have been specified. Quite
often, the query can be constrained in a way that will be much
more useful to the user.

CenterView Itktorio 4



I
Interprocess Communication

SIn te r p r o c e s s C o m m u n ic a tio n m
CenterView can use interprocess communication to send data to other
programs, including the Map program and geotool. Before
CenterView can send data, the interprocess communications software
must be initialized. To insure that this software has been initialized,
execute the following commands.

1. Type source -nmrd/rel/bin/startipc (if you are
running ksh as your shell, type -nmrd/rel/bin/ 3
startipc.ksh).
ISIS is a program that needs to be running on the machine in
order for interprocess communication to work. If ISIS is not 3
running, you will be notified, and you will need to contact staff at
the Center to start it.

2. When prompted for the agent name, enter your login name. I
If ISIS is running, then you will be prompted for an agent name.
The agent name is a name that is given to all processes that you
run, and is unique for each user. Usually, people use their login
names as their agent names

After entering the agent name, the script will start a process 3
called CommAgent, which facilitates the delivery of messages
between programs. The script also sets two environment
variables, AESIRHOST and ISISPORT.

If you wish to learn more about the interprocess communication
layer, you can look at the manpage for CommAgent. 3

3. If you wish to run the Map program, type runMap.
In order to run the Map program, you must be using a color
display, and your DISPLAY environment variable must be set I
correctly.

4. If you wish to run geotool, type run-geotool -a &. 3
Like the map program, it is necessary to have a properly set
DISPLAY enviromnent variable.

If you have any trouble starting any of these processes, someone on I
the Center's Geophysical Systems and Support staff can help you.

l
I
I
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